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Presentation Outline

§ What RDS Is, What It Can Do
§ Use in CF Studio, HS+, DWMX
§ Implications for CFC Browsing
§ Common Challenges, Misconceptions
§ Setup in Server, Editors
§ Security Concerns & Solutions
§ Where to Learn More
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What Is RDS?

§ Remote Development Services
§ Mechanism for accessing resources on a ColdFusion 

server from within editor
§ HTTP-based communication between editor and server to 

facilitate development

-Name suggests intention is for remote access

-But just as useful, perhaps more, for use on own machine 
or within own network

-Supported in CF 3.1, 4, 4.5, 5, MX

-CF Studio 3,4,5; Dreamweaver MX
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What Can It Do?

§ Several features enabled 
§ in CF Studio/HomeSite+
§ And Dreamweaver MX

§ Let’s look at each of them…
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Use in CF Studio, HS+

§ Resource tab>Databases

-Lists all DSNs defined in CF Admin

-Can view all tables, cols, views

-Click plus signs to expand

-Can drag and drop dsn’s, table, cols into editor

-DSN creates CFQUERY skeleton

-Can view all data in a given table

-Double-click table, or right-click>view data

-Can use SQL query builder

-Right-click on table>new query
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Use in CF Studio, HS+ (cont.)

§ Resource tab>Files

-Select “Macromedia FTP&RDS” as a drive

-Expand an RDS server

-Will be shown all drives on that server

-Expand to see files in directories

-Can edit files

-save will save them back to the server
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Use in CF Studio, HS+ (cont.)

§ Windows Explorer/My Computer

-Select “Macromedia FTP&RDS” as a drive

-Expand an RDS server

-Will be shown all drives on that server

-Expand to see files in directories

-Can right-click

-Rename, delete, copy (clipboard) any file

-Edit any file that CF Studio/HS recognizes
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Use in CF Studio, HS+ (cont.)

§ Internal browse

-Need to setup “development mappings”

-“Internal browse” really doesn’t require RDS

-See “where to learn more” for info on setting up, using 
development mappings
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Use in CF Studio, HS+ (cont.)

§ CF Debugger

-Can single-step through code code, etc.

-Does require RDS connection to server

-Must have established development mapping (be able to 
browse) in order to debug

-Debugger is not supported on CFMX server

-See “where to learn more” for info on setting up, using debugger
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Use in DWMX

§ View database metadata info

-See Applications Panel>Databases

-Can view tables, views, stored procs

-See tip later when attempt to use DBs fails

-Right-click>View Data option scrolls 25 at a time

-Also supports drag and drop like CF Studio

-SQL Builder only available by way of bindings, server 
behaviors features

-DWMX RDS features show only if a CF file is opened and a Site 
defined



11

www.systemanage.com       our practice makes you perfect sm

Tip: When DB features fail

§ Sometimes may get error in DWMX attempting to 
gather DB metadata
§ Make sure all DSNs in Admin verify

§ Have noticed that if any fail to verify, DWMX may choke on 
that

§ Have also found that some DSNs that fail to verify can be 
easily fixed
§ Simply edit and save the DSN in admin
§ Try DB feature in DWMX again
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Use in DWMX (cont.)

§ Create database code

-See Application Panel>Bindings

-Click “+” to create new Recordset (query) 

-To create SQL code

-Not available “test” and “advanced” options
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Use in DWMX (cont.)

§ Create database code

-See also Application Panel>Server Behaviors

-Or Insert>Application Objects

-For many other features to generate CF code to 
manipulate DB
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Use in DWMX (cont.)

§ Access Remote/Dev Server Files

-See Site>Edit Site>Remote Info>Access>RDS

-Then use Files panel, Site tab>Remote View

-Note also last icon for expand/collapse, to list both remote and
local files on one screen

-Note get, put, check-in/out features there

-As well as in Site menu
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Implications for CFC Browsing

§ DWMX CFC browsing also leverages RDS

-In DWMX, see Application Panel>Component Explorer

-Note: may take a long time, gathers ALL CFCs on server
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Implications for CFC Browsing

§ Browser-based CFC browsing also leverages RDS

-In browser:

-Browse URL for a given CFC

-Or to view all CFCs, browse 
http://[server:port]/CFIDE/componentutils/componentlist.cf
m

-Or to view all CFC packages, http://[server:port]/ 
CFIDE/componentutils/packagelist.cfm
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Implications for CFC Browsing (cont.)

§ It IS possible to prevent requirement to provide RDS 
password for CFC browsing
§ Just requires a little modification to delete or replace 

application.cfm in [webroot] /CFIDE/componentutils 

-See my blog entry of Feb 24, 2003

-http://cfmxplus .blogspot.com/2003_02_23_cfmxplus_arch
ive.html#90365106

-I offer code to prompt for a new “cfc” password rather than the 
RDS password
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Common Misconceptions

§ RDS only for connecting to remote CF servers
§ Just as useful for localhost and lan servers

§ RDS grants access to all files & databases on server
§ In CF 4,5, was optional Advanced Security mechanism 

for individual or group RDS logins
§ CF 4,5 Adv. Security was Enterprise only

§ Not true. Sandbox Security was Ent Only
§ RDS server settings in CF Studio/HS+ can’t be edited or 

deleted



19

www.systemanage.com       our practice makes you perfect sm

Common Challenges

§ Adding RDS server settings
§ What password, hostname, port, etc.

§ Editing, deleting RDS server settings
§ Hard to find out how to do so

§ You’re typically not given the RDS password for a 
server
§ Admin is concerned about security

§ CFMX no longer offers RDS sandboxing
§ Must provide RDS password to browse CFCs
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Setup in Server

§ In CFMX, RDS is enabled as feature of CFMX server, not 
own service
§ See later “security” section to disable

§ In CF3.1, 4, 5, can be enabled either as service or 
program depending on OS

§ In both, define password in admin
§ More on adv sec approach in CF 4-5, later
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Setup in Server: CFMX
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Setup in Server: CFMX for J2EE

§ Special Sun patch needed to enable RDS on CFMX for 
J2EE
§ See “Installing ColdFusion MX for J2EE on the Sun J2EE 

1.3.1 Reference Implementation on Windows”
§ http://www.macromedia.com/support/coldfusion/ts/docu

ments/tn17203.htm

§ See also “Installing ColdFusion MX for J2EE on other 
J2EE Servers”
§ http://www.macromedia.com/support/coldfusion/j2ee/p

hase2-java-deploy.html

§ Similar technotes for different J2EE servers
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Other Server Setup Issues

§ For Unix/Solaris/Linux and for 4.5, see “hot fix” available 
for RDS
§ http://www.macromedia.com/go/suppissues_cf_hotfixes
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Setup in CF Studio, HS+

§ During install, may be prompted to setup connection to 
RDS server

§ After install, can add RDS servers using:
§ Database tab
§ Options>settings>browse>

development mappings
§ Or Debug>development mappings
§ Or Alt-M
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CF Studio, HS+: Add RDS Server
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CF Studio, HS+: RDS Server Settings

§ Pay attention to needed settings
§ In hostname, just enter domain name or IP

§ No http:// or any other /’s
§ For your own machine, use localhost or 127.0.0.1

§ For port, in CFMX if using built-in web server, set it to 
8500

§ Can select SSL if needed
§ For security fields, typically will enter only a value for 

“password”
§ And it would be the RDS password defined in Admin
§ More on security options later
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CF Studio, HS+: Edit RDS Server Settings

§ Cannot edit or delete RDS server settings using those 
interfaces
§ Must use Files tab or Windows Explorer/My Computer

§ Then, at same level as hard drives, find “Macromedia FTP 
& RDS”

§ Or in CF Studio 4.5 and earlier, “Allaire FTP&RDS”

§ Can then right-click on server, choose properties (or 
delete)
§ Can also use “administer” to open CF Admin
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CF Studio, HS+: Edit RDS Server Settings (cont.)
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CF Studio, HS+: Edit RDS Server Settings (cont.)
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Setup in Dreamweaver MX

§ Must create a “site”
§ And in that site, create “testing server”

§ Then with a CF page open, choose an option that 
leverages RDS
§ Such as Application panel>Databases
§ If first time doing so in this site, will be prompted to enter 

RDS login info
§ This is the Admin RDS password
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Security Concerns: Outsiders

§ Potential unauthorized access by outsiders
§ Anyone with CF Studio/HS+/DWMX can attempt to 

connect to your server
§ Be sure to have Admin RDS password set

§ Never disable password on a network-connected server 
§ Don’t choose easy passwords like “rds”, “admin”

§ Consider adding Web Server security to restrict access to 
/CFIDE/main/ide.cfm
§ Which is the location where editors connect to RDS
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Security Concerns: Insiders

§ Potentially too broad access for insiders
§ Sadly, the default for RDS security on all CF servers is a 

single RDS password
§ All developers who know that can see all DSNs and all 

files/dirs on entire server
§ Really is inappropriate for any non-localhost server

§ Not just commercial hosting provider
§ But also for shared departmental server if multiple 

developers
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Security Solutions

§ In CF 4-5, can assign individual or group logins for RDS
§ Supported by Advanced Security

§ Does NOT require Enterprise
§ Does NOT require use of Adv Sec for applications. Can be 

just for RDS

§ Turn on Advanced Security option
§ then configure “security server”, “user directory”, “security 

context”, “resources to protect”
§ Then turn on “Use ColdFusion Studio Authentication”
§ Then CF Studio/HS+ users should change to use username 

and password
§ Bummer: DWMX only prompts for password
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Security Solutions

§ Disabling RDS entirely
§ If security concerns are too great, can simply disable 

RDS entirely
§ Recommended for production servers

§ Don’t just turn off RDS password in CF Admin, though!
§ Need to disable the RDS capability for the server…
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Security Solutions

§ Disabling RDS entirely (cont.)
§ In CF 3.1, 4, 5, stop the RDS service and set it to 

“manual” in Services panel
§ In CFMX, open WEB-INF\web.xml

§ Comment out RDSServlet mapping

§ See Technote at 
http://www.macromedia.com/support/coldfusion/ts/do
cuments/tn17276.htm

§ Beware: disabling RDS will also disable “browse” applet 
in CF Admin
§ Happens in CFMX as well despite what technote says
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Where to Learn More

§ Using DB, debug, browse, dev mapping tools in CF 
Studio/HS+
§ See manual included in editor Help>Open Help 

References Window
§ Includes manual, “Using ColdFusion Studio” or “Using 

HomeSite+ for Dreamweaver MX”
§ Great resource that many never see

§ Especially see chapters:
§ Configuring Browsers and Servers
§ Accessing Data Sources

§ Debugging Application Code
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Where to Learn More (cont.)

§ Using features in DWMX
§ See Help>Using Dreamweaver MX
§ Especially chapters:

§ Dreamweaver Basics
§ Preparing to Build Dynamic Sites

§ Making Pages Dynamic
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Where to Learn More (cont.)

§ Administration, Security
§ CF 5

§ Installing and Configuring ColdFusion Server, chapter 5 
“Basic ColdFusion Server Administration”

§ Advanced ColdFusion Administration, chapter 3 “CF 
Security”

§ Online at 
http://livedocs.macromedia.com/cf50docs/dochome.jsp

§ CFMX
§ Basic ColdFusion MX Administration, chapter 2
§ Online at 

http://livedocs.macromedia.com/cfmxdocs/dochome.jsp
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Where to Learn More (cont.)

§ My resources
§ More about HomeSite+

§ See my blog entries (cfmxplus.blogspot.com)
§ Mar 5 03, Jan 10 03, Oct 4 02, and Sep 27 02

§ More about DWMX
§ See my blog entries

§ Sep 27 02, Oct 16 02, Nov 12 02, Nov 17 02, Nov 24 02,  
Dec 20 02
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Where to Learn More (cont.)

§ My resources (cont.)
§ CF5 Security Config

§ Toward Better CF Server Administration--Part 2: Security 
§ http://www.sys-con.com/ coldfusion/article.cfm?id=426

§ CFMX Security Config
§ ColdFusion Security, Part I: Understanding 

Sandbox/Resource Security
§ http://www.macromedia.com/ devnet/security/articles/sand

box_01.html

§ Part 2: Setting Up Sandbox/Resource Security
§ http://www.macromedia.com/ devnet/security/articles/sand

box_02.html
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Contact Information

§ Charlie Arehart
§ carehart@systemanage.com
§ http://www.systemanage.com
§ 301 604 8399

§ Available for training (public and on-site) and short-
term, on demand consulting


